
MEMORANDUM 
 
TO: All State Arts Agency Grants & Fiscal Officers 
 
FR: Kelly Liu 

National Standard Associate, NASAA 
 
 Angela Han 

Director of Research, NASAA 
 
DA: August 11, 2008 
 
RE: FY 2008 Grant Reports (NEA Grant #s 07-6100-XXX) 
 FDR Reporting Requirement Reminders 
 

ATTENTION!  
Grant reporting requirements have changed beginning with FY 2008 grants. Please 
read through this year’s memo carefully and contact NASAA or the NEA if you 
have any questions about reporting FY 2008 grants. 
 
 
New this year: 
Consolidation of share fields 
The NEA Share field replaces the SAP (also known as BSP) Share and Other NEA 
Share fields. Funds that were formerly reported in either field should now be reported in 
this field. See Attachment B for further details. 
 
Replacement of NEA Program field 
The NEA Funding Purpose replaces the NEA Program field. This field should be coded 
when funds are reported in the NEA Share field. Multiple codes may be used in this 
field. See Attachments B and F for further details. 
 
Increased federal reporting requirements 
Beginning January 1, 2009 the Federal Funding Accountability and Transparency Act 
will require increased reporting on federal subawards that include more than $25,000 in 
federal funds. See Attachment I for further details. 
 
Reporting regranting activities 
Agencies who report on regranting or decentralized grantmaking activity should refer to 
Attachment A for details on how to report these records.
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It’s that time of year again!  In the next few months, most of you will be reporting on your 
Partnership Agreement grant activities by submitting Final Descriptive Reports (FDRs) 
to the NEA. Federal reporting guidelines also require you to send copies of your FDR 
materials to NASAA at the same time. In cooperation, the Endowment and NASAA use 
your data to show how Partnership Agreement dollars are spent, to describe your 
agency’s recent achievements, and to demonstrate the effectiveness of the state-
federal partnership.  Timely reports from your agency help the NEA maintain 
accountability with Congress, and help NASAA document the public benefits of 
continued government arts funding. 
 
As you prepare reporting materials for the NEA, send the required copy to NASAA, so 
that we may add your statistical information to the national database of all state and 
regional grant awards.  To keep your state’s part of the database in good shape, please 
prepare your FY 2008 files as soon as possible by using the following guidelines, which 
summarize the NEA’s reporting requirements. Full NEA reporting requirements may be 
found at www.arts.gov/manageaward/Partnerships.html.  Please review them carefully. 
 
1. Make sure that your FDR report includes all FY 2008 grants and activities, whether 
or not they involved federal funds.  Please detail how your agency used state, federal 
or other dollars to support all programs and services.  Examples of how to report special 
cases (non-grant program activities, regrants and fiscal agents) can be found in 
Attachment A. If you are not certain how to record an activity in the standard FDR 
format, contact NASAA. 
 
2. The most important part of the NASAA package is the exported “data dump” of 
your grant-making details. Make sure that your data dump lists all of the required data 
elements in the correct sequence, as described in Attachment B. The format of this 
data dump is extremely important. Compare your file to the model provided in 
Attachment C to confirm that your ASCII delimited data dump has been exported 
correctly. Pearl users should consult Attachment D for special instructions (provided as 
a courtesy by Bromelkamp). With prior arrangement, NASAA can also accept .dbf, .mdb 
and .xls files.  
 
3. All agencies are required to use the NEA’s Technology Option for reporting your 
grant-by-grant detail records. Instead of submitting the traditional paper printout of your 
detail records, submit your data dump as usual (always required) along with a Data 
Sequencing Form (see Attachment E). This Data Sequencing Form certifies the 
contents of your CD for the NEA and helps NASAA to map your information into our 
national database. For those agencies with special permission to submit routine paper 
reports, please contact NASAA for instructions. 
 
4. The NEA needs to track how your Partnership Agreement dollars are spent. This is 
done by analyzing information from your NEA Share field as well as the NEA Funding 
Purpose field. When you award money from your Partnership Agreement record those 
federal funds in the NEA Share field (no matter which component). Record the 
appropriate code(s) in the NEA Funding Purpose Field (see Attachment F).  
 
5. You are only required to report on funded activities. Your report and data dump 
need not include records for applications that were denied. 



 
6. States receiving extensions on their NEA grants are required to submit interim FDR 
information, containing all fields and available data, by the original FDR deadline (90 
days after the grant end-date). You must receive NEA Grants Office approval to 
extend your grant. Send the NEA a completed copy of Attachment G after 
forwarding the following materials to NASAA: 

1. A Totals Page, 
2. A CD containing an ASCII dump plus the Data Sequencing Form or the 

paper detail pages, 
3. Answers to the 5 questions found in the interim reporting requirements.  

[See Attachment G.] 
 
7. Once your Final Descriptive Report is prepared, send the appropriate materials to 
the NEA’s Grants Office (not the State & Regional Partnerships Office) and to 
NASAA.   
 
The NEA package should contain: 

one copy of: 
…Your FSR (Financial Status Report), as well as 
two collated copies of: 

  ...The Totals Page,  
  ...The Data Sequencing Form,  

...A CD containing an ASCII dump, 

...The narrative report for Challenge America, American Masterpieces  
   and, if applicable, Folk Arts Infrastructure. 

 
The NASAA package should be mailed to the attention of Kelly Liu at NASAA and 
needs to include one of each of the following:  
  ...An ASCII dump of all FDR data sent via email or saved to a disk/CD,  
  ...One copy of your paper Totals Page,  

...One copy of your Data Sequencing Form,  

...One photocopy of your Challenge America and American Masterpieces  
   reports,  
...A memo indicating if your FDR is an interim or a final and also  
   describing any unique formats or contents. 

 
NASAA can accept your data dumps via email, but we will still need copies of the paper 
components of the report sent to NASAA via snail mail.  If you have any problems 
creating your report or disk, please contact us via phone or email. Thank you! 
 
For copies of the Quick and Easy Guide, Technical Implementation Manual or to see 
examples of how FDR data is used, please consult NASAA’s National Standard 
Reference Center at http://members.nasaa-arts.org/research/ns_center.shtml.  
 

http://members.nasaa-arts.org/research/ns_center.shtml


Reporting Programmatic Activities 
State arts agencies should record programmatic activities in their FDRs. Although these activities are not grants to 
other organizations/individuals, reporting this activity allows the NEA and NASAA to better understand the scope 
of SAA programs and services. Examples of this include artist directories, technical assistance  workshops and 
exhibitions produced by the SAA. 

Each activity should be reported as a separate record with Applicant Name listed as “State Arts Agency-Program 
Description”. All records for these programs and services should be reported with Applicant Status = 05, 
Applicant Institution = 16 and Applicant Discipline = 14. The financial fields for grant amount and project budget 
should all equal each other (Amount Requested, Amount Awarded, Amount Spent, Total Project Expenses, Total 
Project Income). All other fields should be coded to reflect the activity in a manner similar to other grant records. 
See example below.  

Applicant Name 
Applicant City 
 Zip Code   State  

 
Sta 
Inst  

Cong 
ADis 
PDisc  

Type 
PDcpt 
ArtsEd  

YthBen 
Individ 
Artists  

GrRace 
PrjRace  

Request 
Award 
Spent  

Expen 
Income 
In-Kind 

NEA Share  
 
NEA Purpose  

SAA Share 
Other Share 
ID #  

SAA-Artist Exhibition 
Capital City 
12345-0001 ST  

05 
16 

001 
14 
05 

06 
P 
99 

0 
965 
4 

99 
99 

4784 
4784 
4784 

4784 
4784 
0 

0 
 
 

4784 
0 
01-AE300  

 

Contracted services, where the SAA funds a third party to produce programmatic activities, should also be 
reported as separate records. For these records fields should reflect the organization (or individual) producing the 
work, not the SAA. 
 

Reporting Regranting Activities 
State arts agencies that provide grants to organizations for the purposes of regranting are required to report the 
initial grants but not the subsequent regrants. These records should be reported with Activity Type = 26. An 
example of this type of grant record is provided below.  

SAAs who wish to include the subsequent regrants in their FDR must provide these records in a separate data 
dump. 

Applicant Name 
Applicant City 
 Zip Code   State  

 
Sta 
Inst  

Cong 
ADis 
PDisc  

Type 
PDcpt 
ArtsEd  

YthBen 
Individ 
Artists  

GrRace 
PrjRace  

Request 
Award 
Spent  

Expen 
Income 
In-Kind 

NEA Share  
 
NEA Purpose  

SAA Share 
Other Share 
ID #  

Regranting Org 
Capital City 
12345-0001 ST  

02 
16 

001 
14 
14 

26 
 
99 

512 
15070 
316 

99 
99 

81700 
74495 
74495 

74495 
74495 
250 

6000 
 
SAP 

68495 
0 
01-AE301  

 

Reporting Fiscal Agents 
State arts agencies that provide grants to organizations that use fiscal agents are required to report on the fiscal 
agents in the fields about grantees. In the example below, bolded fields refer to the fiscal agent while unbolded 
fields refer to the project activity. 

Applicant Name 
Applicant City 
 Zip Code   State  

 
Sta 
Inst  

Cong 
ADis 
PDisc  

Type 
PDcpt 
ArtsEd  

YthBen 
Individ 
Artists  

GrRace 
PrjRace  

Request 
Award 
Spent  

Expen 
Income 
In-Kind 

NEA Share  
 
NEA Purpose  

SAA Share 
Other Share 
ID #  

Regranting Org 
Capital City 
12345-0001 ST  

02 
16 

001 
14 
14 

26 
 
99 

512 
15070 
316 

99 
99 

81700 
74495 
74495 

74495 
74495 
250 

6000 
 
SAP 

68495 
0 
01-AE302  
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Attachment B 
Required Data Fields and Dump Sequence 

 
Field Name and Order  Field Type Maximum Length  

1  Applicant Name  text  50 characters  
2  Applicant City  text  16 characters  
3  Applicant State  text  2 characters  
4  Applicant Zip  text  5 characters  
5  Zip + 4  text  5 characters  
6  Applicant Status  text  2 characters  
7  Applicant Institution  text  2 characters  
8  Applicant Discipline  text  3 characters  
9  Congressional District  text  3 characters  

10  Project Discipline  text  3 characters  
11  Activity Type  text  2 characters  
12  Project Descriptors1  text/logic  5 characters or 5 true/false fields  
13  Arts Education  text  3 characters  
14  Total Individuals Benefiting  numeric  8 digits  
15  Artists Participating  numeric  6 digits  
16  Children/Youth Benefiting  numeric  6 digits  
17  Grantee Race2  text  6 characters or 6 true/false fields  
18  Project Race  text  2 characters  
19  Amount Requested  numeric  8 digits  
20  Amount Awarded  numeric  8 digits  
21  Amount Spent  numeric  8 digits  
22  Total Project Expenses  numeric  8 digits  
23  Total Project Income  numeric  8 digits  
24  Total Project In-Kind  numeric  8 digits  
25  NEA Share  numeric  8 digits  
26  SAA Share  numeric  8 digits  
27  Other Share  numeric  8 digits  
28  NEA Funding Purpose3  text  18 characters 

 29  Application Number4  text/numeric  9 characters  
30  Constituent ID5  text/numeric  10 characters  
31  Custom Project Descriptors6    

NEW 

NEW 

 
NEW FOR FY 2008 
• NEA Share: This field is a consolidation of the BSP Share and Other NEA Share fields from prior years. Funds 

that were formerly reported in either of these fields should now be reported in the NEA Share field. 
• NEA Funding Purpose: This field replaces the NEA Program field. This field should be coded any time funds 

are reported in the NEA Share field. Please refer to Attachment F for a description of these codes. 
• Field reduction: There are now 31 data fields due to the consolidation of share fields. Fields formerly numbered 

27 through 32 are now numbered 26 through 31. 
 
 
Notes 
1
 Multiple selections are allowed for this field. Agencies may choose to put the multiple selections in one field or to put each selection in its own 

logic field. If each code is stored in its own field, the fields must be in the following order [A, I, P, T, Y] and inserted in the data dump after 
Activity Type and before Arts Education.  
2
 Multiple selections are allowed for this field. Agencies may choose to put the multiple selections in one field or to put each selection in its own 

logic field. If each code is stored in its own field, the fields must be in the following order [A, B, H, N, P, W] and inserted in the data dump after 
Youth Benefiting and before Project Race.  
3
 Although not part of the National Standard, this field is required by the NEA. See Attachment F for more information.  

4
 Indicates each agency’s unique system of grant identification numbers

  

5
 Indicates each agency's unique identification number used in its constituent list or mailing list database. A grantee’s Dun & Bradstreet DUNS 

number may be used, if the agency collects these. A grantee’s Federal Employer Identification Number (FEIN) may also be used. Although 
reporting this field to NASAA and the NEA is voluntary, agencies are strongly encouraged to include this information.  
6
 If your agency has added optional codes to the Project Descriptors fields, insert them at location 31 in the data dump. Text codes embedded in a 

single, consolidated field may be reported in any order. However, if your agency uses separate logic fields the following sequence must be used: 
[C] Cultural Heritage Tourism, [E] Economic Development, [H] Health/Healing and [O] Older Adults. When including custom codes, your data 
dump to NASAA must be accompanied by a key that lists all codes used and their definitions 
 



The ASCII Delimited Data Dump File for Your FDR 
 
An ASCII delimited dump is a text file where each grant record appears on its own single line.  Fields are separated by commas, tabs, or spaces.  
When you have finished saving your FDR data to a disk, check to see that it is in a delimited format and that all information appears in the 
sequence shown in Attachment B. 
 
You should export your FDR data so that the dump looks like this: 
 
In a comma delimited format 
 
"Artspace","Anahiem","AK","99072",”7175”,"02","15","14","1","14","11","TY","99",5500,1800,2400,"99","99",1283,3886,3886,13831,15062,3020,3886,0,0,SAP,"855" 
"Ctr for Children","Anahiem","AK","99401",”9211”,"02","25","14","1","12","20","P","01A",95,1,49,"NW","99",677,525,525,1554,1810,256,525,0,0,"PAE","1077" 
 
In a tab delimited format 
 
"Artspace" "Anahiem"  "AK" "99072"  “7175” "02" "15" "14" "1" "14" "11" "TY" "99" 5500 1800 2400 "99" "99" 1283 3886 3886 13831 15062 3020 3886 0 0 SAP "855" 
"Ctr for Children" "Anahiem"  "AK" "99401"  “9211” "02" "25" "14" "1" "12" "20" "P" "01A"  95 1 49 "NW" "99" 677 525 525 1554 1810 256 0 525 0 0 "PAE" "1077" 
 
The delimited formats above are most efficient for our database to import.  We also encourage you to include the field names as the first line in the 
data dump.  Field names can help us map each data element into its proper field in the national database of all SAA and RAO grants. 
 
 
Your file should NEVER look like this: 
Artspace 1 11 2400  12832 13831 3886 0 
Anahiem 02 14 TY 5500 99 3886 15062  0 
99072-7175 AK 15 14 99 1800 99 3886 3020 SAP 855 
Ctr for Children 1 20 49  677 1554 525 0 
Anahiem 02 14 P 95     NW 525 1810  0 
99401-9211 AK 25 12 01A 1  99 525 256 PAE 1077 
 
This happens when a report is saved to a file instead of exported to a file.  This format can not be efficiently imported into the national database. 

A
ttachm

ent C
 

 
If you have questions regarding these formats or how to export your FDR to file, please contact Kelly Liu at NASAA for assistance. 
 

National Assembly of State Arts Agencies. 7/2008 



Attachment D 
Before you begin: recent changes in reporting requirements necessitate changes to your Pearl database.  If you 
have not already contacted Bromelkamp about these changes, please call 877-767-6703 for help and advice.   

A. Printing out the FY08 FDR Report with Pearl Software 
1. Open Pearl so that the Pearl Navigator is displayed 
2. Click the “Reports” radio button and view the list of available reports.  Find the report called “FY08 FDR Report” (or 

similar) 
- If you find it, go directly to step 3 
- If you don’t find it, but you find a report called “FY07 FDR Report” (or similar), go to step 4 
- If you don’t find it, and you don’t find a report called “FY07 FDR Report” (or similar) call our office at  

(877) 767-6701 x3.  We can estimate the cost to configure the basic report for your system.  
3. Click once on the report to select it, then click the Print button. [END of instructions] 
 
4. While you are still in the Pearl Navigator, with the “Reports”  displayed, click the “Design” button to use Pearl Designer 
5. Drop down the Window menu and choose “Unhide”, then click the OK button on the unhide window, and the Access database window will appear 
6. Click the reports tab, then find the report called “FY07 FDR Report” (or similar), and click on it once, to select it 
7. Drop down the edit menu and choose “copy”, then drop it down again and choose “paste.” 
8. A copy of the report (with a “1” after the name) will appear, selected. Right-click it, and choose “rename.”   
9. Change 07 to 08, and remove the extra “1” at the end, and press Enter.  The new report will still be selected.  Click the “design” button.   
10. Drop down the View menu and choose “properties.”   Click the “All” tab in the properties window. 
11. The first property is “record source.”   If the Record Source is “qryFY07” continue to the next step.  If it’s anything else, call our office for help. 
12. Click in the record source field near the words “qryFY07”, and then click on the drop-down box at the right of the field.  Find “qryFY08” and select it. 
13. Close the report and save it.  Then, drop down the Window menu and choose “Pearl Navigator.” 
14. Refresh the reports list by clicking on Forms then, clicking back on Reports.  Follow step 3, above. 
15. When convenient, return to Pearl when you can open it exclusively and import your new report from Pearl Designer into Pearl.   

B. Preparing the FY08 FDR data file with Pearl Software 
1. Open Pearl so that the Pearl Navigator is displayed, then drop down the Window menu and choose “Unhide” 
2. Click the OK button on the unhide window, and the Access database window will appear 
3. Click the queries tab, then find the query called “qryFY07 FDR export” (or similar) 
- If you find it, skip to step 4  
- If you don’t find it, but you find a query called “qryFY07 FDR export” (or similar), go to step 14 
- If you don’t find it, and you don’t find a query called “qryFY07 FDR export” (or similar) call our office at  

(877) 767-6701 x3.  We can estimate the cost to configure the basic query for your system.  
4. Double click the query “qryFY08 FDR export”, then drop down the File menu and choose “Export.” 
5. In the “Save qryFY08 FDR export in…” window, navigate to your Pearl folder  
6. Drop down the code list for the “Save As Type” field at the bottom of the window and choose “Microsoft Word merge 

(*.txt)” 
7. Type XXFY08.txt in the “file name” field (use the two-digit abbreviation for your state for XX, such as NYFY08.txt) 
8. Click the “Export” button, then if the Export Text wizard appears, go on to the next step; otherwise skip to step 13. 
9. Select “delimited – characters such as comma or tab separate each field”, then click the “Next” button 
10. In the section called “choose the delimiter that separates your fields” select “comma” 
11. In the “Text qualifier” field drop down the code list and choose the double-quotes ("), then click the “Finished” button 
12. Click OK to the window that tells you it’s finished exporting. 
13. You can attach the file to an email and send it to kliu@nasaa-arts.org or you can insert a diskette and save it there.  

 
14. Click once on the query called “qryFY07 FDR export” (or similar) to select it 
15. Click the “design” button at the right of the database window 
16. Drop down the “view” menu and choose SQL view.  A lot of text will display, and it will all be selected. 
17. Drop down the edit menu and choose “copy”, then minimize Pearl and open a new document in Microsoft Word 
18. Drop down the edit menu and choose “paste”, then drop down the edit menu again and choose “select all” 
19. Drop down the edit menu again and choose “replace”.  The “Find and Replace” window will display 
20. In the “Find what” field, type FY07, and in the “Replace with” field, type FY08.   
21. Click the “Replace All” button.  Click OK when it tells you how many replacements it made, then click the “Close” button. 
22. Drop down the edit menu again and choose “copy.”  Then exit Microsoft Word, you don’t need to save the new document. 
23. Maximize Pearl, make sure the query’s SQL text is still selected, then go to the Edit menu and choose “paste” 
24. Close the query and save the changes 
25. Right-click on the query and choose “rename”, and change the 07 to 08 then press Enter. 
26. Go back and follow steps 4-14, in section B. above. 
 
Call our office at (877) 767-6703 with questions, or for help with any of the steps above. 

mailto:kliu@nasaa-arts.org


 
Final Descriptive Report Part 1:  Data Sequencing Form 
Point and click or tab to each space and enter data. 
 
SAA:       
 

NEA Grant #:  0  - 6100 - 2     Final or  Interim?  Final to be sent (date)      . 
 

Total # of grants/records in file:       
 Export Format of File--select one 
Name of File:         ASCII text delimited (preferred) 

 ASCII tab delimited 
Software used to produce the file:   Access   Excel 
       Other:       
 

List of fields IN THE EXACT ORDER in which they appear in the data dump: 
 Field Name Type* Max Length
1.       
2.       
3.       
4.       
5.       
6.       
7.       
8.       
9.       
10.       
11.       
12.       
13.       
14.       
15.       
16.       
17.       
18.       
19.       
20.       
21.       
22.       
23.       
24.       
25.       
26.       
27.       
28.       
29.       
30.       
31.       
*Text/character, numeric, or logical 

 

Contact information for questions about the content or format of the data file: 
Name:       
Title:       
Phone: (     )        -       E-mail:       

Attachment E 



  Attachment F

Codes for “NEA Funding Purpose” Field 
 
 

Every grant record using “NEA Share” funds must contain a reference to the purpose(s) 
being addressed through the use of the NEA funds.  Select code(s) from the list 
provided below and enter in the “NEA Funding Purpose” field to identify the purpose of 
the award.  (If the grant in question addresses more than one purpose, enter all codes 
in the field.) 
 
 
 

List of Valid “NEA Funding Purpose” Codes for State Arts Agencies 
 

 
Partnership Agreement Grants – State Arts Agencies 
 

SAP    State Arts Plan Priorities 

PAE Arts Education  

PAU Underserved Communities  

PAC Challenge America  

PAM  American Masterpieces 

FAI Folk & Traditional Arts Infrastructure  

POL Poetry Out Loud 

 
 
 



Revised 04/08                                              

INTERIM REPORTING REQUIREMENTS ON EXTENDED GRANTS 
(grant numbers beginning 07-6100-2XXX, 08-6100-2XXX, etc.) 

 
As a condition of the grant extension on your NEA Partnership Agreement grant you must submit 
an interim descriptive report at the time the original final descriptive report (FDR) would 
have been due.  The interim data allow us to keep our state/regional grant database current and 
respond to Congressional and media inquiries with more complete and up-to-date facts while 
enabling us to approve your request for additional time.  
 
The FDR consists of two parts: Statistical Information and a Narrative Requirement.  Interim 
reporting is needed for both Parts I and II. 
 
For Part I: Statistical, i.e., the computer listing of your activities in National Standard format, the 
interim report should include all of the fields for which you have data at the time the interim report is 
due.  The share field information is critical because it allows us to document the reach of Federal 
funds.  In addition, you must answer the five questions on the next page about the status of the 
data on which you are reporting.   For Part II: Narrative Requirement.  The interim narrative 
should respond to the questions posed in the Final Descriptive Report Instructions on our Web site. 
 
STEP 1: Document the contents of your report thoroughly as per NASAA’s annual memo on this 
subject.  Send the following to NASAA: (1) a diskette with an ASCII dump of your Statistical 
information, (2) a Totals Page, (3) Data Sequence Form and (4) answers to the five questions (on 
the next page) about the status of your data.  Send to: 

Kelly Liu 
National Assembly of State Arts Agencies 
1029 Vermont Avenue NW 2nd Floor 
Washington, DC 20005 
Phone: 202/347-6352    Email: kliu@nasaa-arts.org 

 
STEP 2: Complete the grant number and signature block below and fax this sheet, the interim 
narrative, and the answers to the five questions on the following page to: 

Andi Mathis 
State & Regional 
National Endowment for the Arts 
Phone: 202/682-5430    Fax: 202/682-5613 

 
The interim descriptive report for the Partnership Agreement grant  0   - 6 1 0 0 – 2         (please 
complete 10-digit grant number) has been completed and sent to NASAA at the above address. 
 
 

Name: 
      

Signature:  Date:   /    /   

Agency: 
      

 

Attachment G - 1



Revised 04/08                                              

INTERIM REPORTING REQUIREMENTS ON EXTENDED GRANTS (cont.) 
(grant numbers beginning 07-6100-2XXX, 08-6100-2XXX, etc.)  

 
In order to measure performance in accordance with the Government Performance and results Act, 
the Arts Endowment needs extensive and timely information on activities supported by its state and 
regional partners.  Fortunately, the National Standard Final Descriptive reporting fields cover much 
of the information that is currently needed.  However, frequent delays in reporting, due to grant 
period extensions and reporting deadline extensions, have often made it impossible to get the 
information when needed.  By the time the Arts Endowment is able to provide a complete picture of 
activities supported in all states, the information may be three or four years old.  Such outdated 
information is not adequate to meet new requirements. 
 
To address this problem while continuing to remain responsive to requests for grant period 
extensions, State Partnership Agreement awards will be subject to the following reporting policy: 
 
A An agency that receives a grant period extension or an extension of its final report deadline 

will be required to submit an interim report no later than 90 days after the original end date 
of the grant.  The interim report must include all available National Standard data on 
activities supported under the grant.  On activities for which grants have been awarded, but 
not completed, agencies should provide information from fields 1-13, 17-21, and 25-29 (from 
the list of reporting conventions). 

 
B An agency submitting an Interim Report must respond to the following questions: 
 

1.  What percentage of your total agency program budget (Federal and non-Federal 
funds) is covered by this Interim Report?  This percentage should include all grants 
for which awards have been made.  (This question refers to percent of dollars.) 

 
2. What percentage of this total is Federal? 

 
3. Of the total number of grants and funded activities to be included in your FDR, what 

percentage does this report contain? (This question refers to percent of grant(s) 
activity.) 

 
4. How many of the grants and funded activities reported in #3, above, include Federal 

dollars? 
 

5. Are there any categories for which data are not yet available and are excluded from 
this report? 

 
Endowment grants will not be awarded to State Arts Agencies that are delinquent with respect to 
this interim reporting requirement.  Your understanding and cooperation are greatly appreciated.  

Attachment G - 2



National Standard “Cheat Sheet” 

Applicant Status 
01 Individual 
02 Organization - Non-Profit 
03 Organization - Profit 
04 Government - Federal 
05 Government - State 
06 Government - Regional 
07 Government - County 
08 Government - Municipal 
09 Government - Tribal 
99 None of the Above 
 
Type of Activity 
01 Acquisition  
02 Audience Services  
03 Fellowships  
04 Artwork Creation  
05 Concert/Performance/Reading 
06 Exhibition  
07 Facility Construction/Maintenance 
08 Fair/Festival  
09 Identification/Documentation  
10 Organization Establishment  
11 Operating Support  
12 Arts Instruction 
13 Marketing  
14 Professional Support - Administrative 
15 Professional Support - Artistic 
16 Recording/Filming/Taping  
17 Publication  
18 Repair/Restoration/Conservation 
19 Research/Planning 
20 School Residency 
21 Other Residency 
22 Seminar/Conference  
23 Equipment Acquisition  
24 Distribution of Art  
25 Apprenticeship  
26 Regranting  
27 Translation 
28 Writing About Art 
29 Professional Development/Training 
30 Student Assessment 
31 Curriculum Development/Implementation 
32 Stabilization/Endowment/Challenge 
33 Building Public Awareness 
34 Technical Assistance 
35 Web Site/Internet Development 
36 Broadcasting 
99 None of the Above 
 
 
 

Applicant Institution 
01 Individual Artist  
02 Individual Non-Artist  
03 Performing Group  
04 Performing Group - College/University  
05 Performing Group - Community 
06 Performing Group - Youth  
07 Performance Facility  
08 Art Museum  
09 Other Museum  
10 Gallery/Exhibit Space  
11 Cinema  
12 Independent Press  
13 Literary Magazine  
14 Fair/Festival  
15 Arts Center  
16 Arts Council/Agency  
17 Arts Service Organization  
18 Union/Professional Association 
19 School District  
20 Parent-Teacher Organization 
21 Elementary School  
22 Middle School  
23 Secondary School  
24 Vocational/Technical School  
25 Other School 
26 College/University  
27 Library  
28 Historical Society  
29 Humanities Council  
30 Foundation  
31 Corporation  
32 Community Service Organization 
33 Correctional Institution  
34 Health Care Facility  
35 Religious Organization  
36 Seniors’ Center  
37 Parks and Recreation  
38 Government - Executive 
39 Government - Judicial  
40 Government - Legislative (House) 
41 Government - Legislative (Senate) 
42 Media - Periodical  
43 Media - Daily Newspaper  
44 Media - Weekly Newspaper  
45 Media - Radio  
46 Media - TV  
47 Cultural Series Organization  
48 School of the Arts 
49 Arts Camp/Institute 
50 Social Service Organization 
51 Child Care Provider 
99 None of the Above 
 

Disciplines (Applicant & Project) 
01 Dance  
  A Ballet 
  B Ethnic/Jazz 
  C Modern  
02 Music   
  A Band 
  B Chamber 
  C Choral 
  D New 
  E Ethnic 
  F Jazz 
  G Popular 
  H Solo/Recital 
  I Orchestral 
03 Opera/Musical Theatre  
  A Opera 
  B Musical Theatre  
04  Theatre  
  A General 
  B Mime 
  D Puppet 
  E Theatre for Young Audiences  
05  Visual Arts  
  A Experimental 
  B Graphics 
  D Painting 
  F Sculpture  
06 Design Arts  
  A Architecture 
  B Fashion 
  C Graphic 
  D Industrial 
  E Interior 
  F Landscape Architecture 
  G Urban/Metropolitan  
07 Crafts   
  A Clay 
  B Fiber 
  C Glass 
  D Leather 
  E Metal 
  F Paper 
  G Plastic 
  H Wood 
  I Mixed Media 
08 Photography   
09 Media Arts   
  A Film 
  B Audio 
  C Video 
  D Technology/Experimental 
 
 

Disciplines (Continued) 
10 Literature  
  A Fiction 
  B Non-Fiction 
  C Playwriting 
  D Poetry  
11 Interdisciplinary   
12 Folklife/Traditional Arts   
  A Folk/Traditional Dance 
  B Folk/Traditional Music 
  C Folk/Traditional Crafts & Visual Arts 
  D Oral Traditions (include folk/traditional 
13 Humanities     storytelling) 
14 Multidisciplinary   
15 Non-Arts/Non-Humanities 
 

Arts Education 
01 50% or more of  project activities are arts 
  education directed to: 
  A K-12  
  B Higher education  
  C Pre-kindergarten  
  D Adult learners  
02 Less than 50% of project activities are arts 
  education directed to: 
  A K-12  
  B  Higher education  
  C  Pre-kindergarten  
  D Adult learners  
99 No arts education  
 

Project Descriptors 
A Accessibility 
I International 
P Presenting/Touring 
T Technology 
Y Youth at Risk 
 

Grantee Race 
A Asian 
B Black/African American 
H Hispanic/Latino 
N American Indian/Alaska Native 
P Native Hawaiian/Pacific Islander 

A
ttachm

ent H
 

W White 
99 No single group (organizations only) 
 

Project Race 
A Asian 
B Black/African American 
H Hispanic/Latino 
N American Indian/Alaska Native 
P Native Hawaiian/Pacific Islander 
W White 
99 No single group 



Federal Funding Accountability and Transparency Act (FFATA) 
 
Beginning January 1, 2009 federal subawards (i.e., grants that state arts agencies award that contain 
federal funds) will be required to comply with the Federal Funding Accountability and Transparency Act 
(FFATA). The FFATA specifies data on federal awards that must be made available to the general public. 
Details on reporting requirements for subawards are still being finalized. Information presented here is 
accurate as of August 2008. 
 
Who does this affect? 
State arts agency grantees receiving more than $25,000 in federal funds. 
 
 
What is required of state arts agencies? 
The specifics of how federal grantees will need to report their subawards is still being determined. 
Agencies interested in participating in a pilot program to test out the reporting process should contact 
Andrea Brandon at the USDA, abrandon@csrees.usda.gov or (202) 401-6021 
 
 
What is required of SAA grantees receiving more than $25,000 in federal funds?  

1. A Dun & Bradstreet DUNS number. This unique nine-digit identifier is free to obtain through 
Dun & Bradstreet. Grantees may request a DUNS number by going to 
http://fedgov.dnb.com/webform/displayHomePage.do.  

2. Registration in the Central Contractor Registration (CCR) system. Grantees can register into the 
system by going to http://www.ccr.gov.  

 
 
What will be done with this information? 
Information on federal contracting dollars and grant awards collected through the FFATA is posted to 
http://www.usaspending.gov.  
 
 
Where can I go for more information? 
Federal Registers detailing the proposed reporting requirements can be accessed here: 

http://edocket.access.gpo.gov/2008/pdf/E8-12558.pdf  
http://edocket.access.gpo.gov/2008/pdf/E8-12560.pdf  

 
For further information contact Nicki Jacobs, NEA Director of Grants and Contracts, at (202) 682-5400 
or jacobsn@arts.endow.gov.  
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